
11 Acquiring and Editing Audio

Audio is critical to your students’ video productions and Adobe® 
Premiere® Pro 2.0 has the right complement of tools to take their audio 
editing to a higher level. It features industry-standard plug-ins, audio 
conforming, sample-specific editing, and multiple track types. To ensure 
the highest audio quality, select the right microphones (mics) for the 
job, turn to wireless audio if your budget allows, and use professional 
voiceover techniques.

Audio typically takes a back seat to video, but it’s crucial to video 
projects. The best images lose their impact if their audio is mediocre. 
Your students’ objective is to acquire high-quality audio at the get-go, 
both in the field and when recording a narration. That means using the 
right mics and using them correctly.

Adobe Premiere Pro gives video producers and audiophiles all they need 
to add top-notch aural quality to their productions. Adobe Premiere 
Pro has a built-in audio mixer that rivals hardware found in production 
studios—it lets you edit in mono, stereo or 5.1 surround sound, has a 
built-in instrument and vocal recording feature, and gives you several 
ways to mix selected tracks.

You can perform industry standard edits like L- and J-cuts on the 
Timeline as well as adjust audio volume levels, keyframes, and 
interpolation.

In addition, Adobe Premiere Pro’s compliance with two audio industry 
standards: ASIO (Audio Stream In/Out) and VST (Virtual Studio 
Technology) ensure that it works smoothly with a wide range of audio 
cards and accepts dozens of audio effect plug-ins. I cover those plug-
ins, the full range of audio effects in Adobe Premiere Pro, and its Audio 
Mixer in Module 12.
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Module Overview
Topics covered in this module:

•	 Selecting the right mic for the job.
•	 Connecting microphones to your camcorder or PC.
•	 Building a voice recording area.
•	 Voicing professional narrations.
•	 Adobe Premiere Pro—a high-quality aural experience.
•	 Examining audio characteristics.
•	 Adjusting audio volume.
•	 Adding J- and L-cuts.

Selecting the Right Mic for the Job
Most likely your students work with camcorders that have onboard 
mics. Onboard mics take the middle ground. They pick up sound 
from everywhere, including wind, the hum of overhead fluorescent 
lights, noises made while handling the camcorder, as well as the 
zoom lens motor.

What your students need are external mics: specialized mics that 
serve narrower but useful functions. Here are the four basic types 
that suit most circumstances:

•	 Handheld
•	 Shotgun
•	 Lavaliere
•	 Surface mount

Four standard-issue mics: handheld, shotgun, lavaliere, and surface mount  
(Used by permission. Shure, Inc.  2005)
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Handheld Mic

Handheld mics are the workhorses of the audio industry. Since they are built with 
internal shock mounts to reduce handling noise, you'll use these mics for interviews, 
place them on podiums to record speeches, and use them to create narrations.

Many handheld mics are omnidirectional, meaning that they pick up sound from all 
directions. They'll pick up ambient room noise as well as close-up audio. To minimize 
that unwanted noise, keep the mic as close to your subject as practical—usually about a 
foot from the speaker's mouth.

Basic handhelds start at about $25. Top-of-the-line,  durable handhelds start at $150.

Position handheld mics 12 inches from the  
speaker’s mouth at an angle of about 45°. That  
cuts down on pops made by your breath when  
you pronounce Ps and Ts.  
(Used by permission. Shure, Inc.  2005)

Shotgun Mic

So-named because it resembles a shotgun barrel, the shotgun mic's unidirectional barrel 
(called an interference tube) narrows the focus of the audio field to about 30 degrees.

Shotgun mics don't zoom. Think of them as looking through a long tube. They narrow 
your "view" of the sound.

Note: The telephoto lens equivalent in the microphone world is a parabolic dish. You've 
seen networks use them along the sidelines of NFL games to get those great crunching hits.

Shotgun mics are a great way to reduce ambient noise and work well during informal, 
impromptu interviews. Instead of shoving a handheld mic in a nervous interviewee’s 
face, hold a shotgun mic farther away.

A good shotgun mic will set you back about $1,000.
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Lavaliere Mic

Lavalieres are perfect for formal, sit-down interviews. Their tiny size means that you can 
conceal them to minimize that "Oh, we're watching TV" disconnect. The downside is that 
most require batteries. You can buy a basic lav at an electronics store for $25. High quality 
lavs start at $200.

Surface Mount—Boundary—Mic

You'll use these specialized mics to pick up several speakers at a conference table or on a 
theater stage. They're built to be placed on a flat surface and pick up sound waves both in 
the air and from the hard surface. A basic omni-directional boundary mic costs $40. Higher 
quality boundary mics cost about $150.

Wireless Systems and Mics

Wireless mics open a whole new spectrum of possibilities, enabling you to record sound 
from a distance. After you've used one, you'll wonder how you got along without it.

Depending on the wireless system, you can either hook up standard mics—handheld, 
shotgun or lavaliere—to a wireless transmitter or use mics with built-in transmitters. Entry-
level set-ups cost about $200. Top-of-the-line systems retail for $2,000.

(Used by permission. Shure, Inc.  2005)

   Tip: Best Single-Mic Solution

If I had to choose a single-mic system solution, I’d go with a wireless shotgun mic. A 
shotgun mic is versatile and going with a wireless transmitter gives you great mobility. 
You can get crystal-clear audio even though the mic might be far from you on a 
podium, or in your producer’s hands in the middle of a crowd. Interviews will be more 
spontaneous—the mic can be less obtrusive than a typical handheld mic, and there is no 
awkward pause while plugging a cable into the camera. 



Module 11 235
ADOBE PRODUCTION STUDIO CURRICULUM GUIDE

Connecting Mics to Your Camcorder or PC
Professional camcorders use rugged, reliable, three-pronged XLR jacks, which match 
professional mics and cables.

Most consumer and higher-quality prosumer camcorders use mini-plug connectors and 
do not have enough amplification to "hear" standard handheld mics.

So try before you buy. Take your camcorder to the electronics store and test some mics. 
You might need to buy an XLR-to-Mini adapter or a phantom power amplifier to use 
certain mics. Both cost less than $100 each.

Making the PC Connection

Adobe Premiere Pro lets you record a narration directly to your project using a mic 
connected to your PC’s sound card. Most sound cards have only a 1/8” (3.5mm) stereo 
minijack outlet. Mics built specifically for PC use typically cost less than $25. When you 
visit your local electronics store, you’ll have two basic options:

•	 Dynamic mics—Headset or a long-neck version that sets on your desk.

•	 Condenser mics—These typically are lavalieres, offer slightly better voice-over 
quality and require a battery.

Plug the mic into the correct soundcard outlet (usually marked Mic or with a mic icon) 
and not the Line-in jack used with amplified devices such as CD players and sound 
mixers.

Whichever mic you choose, make sure that you also get a good headset—one that covers 
the ears to block out extraneous sound. Use that headset both when shooting your video 
and voicing a narration. It’s important to hear how the mic hears you.
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Setting up a Basic Voice-Recording Area
To create a voiceover narration, you'll need a quiet, sound-absorbing location. The 
easiest solution is to build a temporary recording area simply by hanging some 
thick blankets or fiberglass insulation on two joining corner walls. If you can create 
something like a four-sided, blanketed cubicle, so much the better.

It is an old audio myth that egg cartons, carpeting, and foam rubber work well. Avoid 
them.

If you drape the blankets only in one corner, point the mic toward that corner, place 
yourself between the mic and the corner, and speak away from the blankets. It seems 
counter intuitive, but the mic is sort of like a camera. It “sees" what's in front of it. In this 
case, it sees your face and the hanging, sound-absorbing blankets.

Voicing Solid Narrations
Go over this checklist before recording a voiceover:

•	 Practice reading your copy out loud—Listen to your words. They should sound 
comfortable, conversational, even informal.

•	 Avoid technical jargon—That demands extra effort from your listeners, and you 
might lose them.

•	 Short sentences work best—If you find yourself stumbling over certain phrases, 
rewrite them.

•	 Stress important words and phrases—As you review your copy, underline 
important words. When you record your voiceover, you'll want to give those words extra 
emphasis—more volume and punch.

•	 Mark pauses—Mark logical breaks in narration with short parallel lines.

•	 Avoid overly smooth and constant pacing—That's characteristic of a scripted 
delivery. You don't want to remind viewers that this is TV. It's real life. It's 
conversational.

•	 Punch up your voice—Do not slip into a dull, monotone voice. Instead, add some 
zest and enthusiasm to your narration. 

•	 Practice—Record a couple narrations and listen. Most first-time narrators mumble 
or swallow words. Have you made yourself clear?

•	 Don’t pop your Ps and Ts—As you say P- and T-words, you project a small blast of 
wind. Avoid speaking directly into the mic.
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•	 Wear a headset—It’ll help you avoid popping P's or speaking with too much 
sibilance—an overemphasis on the S sound. And it’ll help you minimize room noise and 
other extraneous sounds.

Adobe Premiere Pro—A High-Quality Aural Experience
Adobe Premiere Pro offers professional-quality audio editing tools that rival many 
stand-alone audio mixing and editing products. For example:

•	 Sample-specific edits—Video typically has between 24 and 30 frames per second. 
Edits fall between frames at intervals of roughly 1/30 second. Audio typically has 
thousands of samples per second. CD audio is 44,100 samples per second (44.1kHz). 
Adobe Premiere Pro lets you edit between audio samples.

•	 Three types of audio tracks—Mono, Stereo, and 5.1 (six-channel surround). You can 
have any or all of these tracks types in a sequence.

•	 Submix tracks—You can assign selected audio tracks to a Submix track. That lets you 
apply one instance of audio and effect settings to several tracks at once.

•	 Channel editing—You can split out individual audio channels from stereo and 5.1 
surround sound files and apply effects only to them. For example, you can select the two 
rear channels in a 5.1 track and add reverb to them.

•	 Recording studio—you can record any instrument or mic that you can connect to an 
ASIO-compliant sound card. Record directly to a track on an existing sequence or to a 
new sequence.

•	 Audio conforming—Adobe Premiere Pro upconverts audio to match your project’s 
audio settings. In addition, it converts so-called fixed-point (integer) data to 32-bit 
floating point data. Floating point data allow for much more realistic audio effects 
and transitions. Note: Floating point data have no fixed number of digits before and 
after the decimal point; that is, the decimal point can float. This leads to more accurate 
calculations—down to as many decimal places as Adobe Premiere Pro’s 32-bit audio 
conforming allows.
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Task: Examining Audio Characteristics
Audio editing is similar to video editing. It uses most of the same tools and you apply 
transitions and effects in much the same way.

But audio has some characteristics that are different than video and do affect the way you 
approach audio editing. In this and the remaining mini-lessons, I introduce you to audio 
editing. As I mentioned earlier, in Module 12, you will work with Adobe Premiere Pro’s 
Audio Mixer and audio effects and I will give you a brief demo of Adobe’s professional 
audio product, Audition® 2.0.

For this task, your students will need some sound samples. I suggest a monaural narration 
and a monaural musical selection, a stereo music clip with distinctive left and right 
channel instrumentation, two other brief music clips, and a 5.1 surround sound music 
sample. You’ll also need the sound bites and the cutaway your students worked on in 
Module 8.

1	 Open Adobe Premiere Pro, open a new project with a preset that uses 48kHz audio, 
and import the audio clips.

Note: Even if the audio clips your students use for this project are not 48kHz (48,000 samples 
per second), Adobe Premiere Pro will up-convert them to match the project settings.

2	 Double-click the narration file to open it in the Source Monitor.

That displays a waveform. The peaks and valleys indicate volume levels.

Note: As highlighted in the next figure, the Toggle Take Audio and Video button 
automatically switches to Audio-only when you add an audio-only clip to the Source 
Monitor.

   Camcorder kHz and Bit Rate Settings

Many DV camcorders give you two audio quality options: 16-bit audio recorded at 
48kHz (48,000 samples per second with 16-bits of data per sample) or lower quality 
12-bit audio recorded at 32kHz. The latter option lays down two stereo tracks on your 
DV cassette: one with audio recorded by the on-camera mic and the other giving you an 
option to insert a narration or some other audio. If you recorded at 32kHz and set your 
project to 48kHz, that is not a problem. Adobe Premiere Pro will simply take a little 
longer to upconvert your audio during the conforming process. 

   Camcorder kHz and Bit Rate Settings

Many DV camcorders give you two audio quality options: 16-bit audio recorded at 
48kHz (48,000 samples per second with 16-bits of data per sample) or lower quality 
12-bit audio recorded at 32kHz. The latter option lays down two stereo tracks on your 
DV cassette: one with audio recorded by the on-camera mic and the other giving you an 
option to insert a narration or some other audio. If you recorded at 32kHz and set your 
project to 48kHz, that is not a problem. Adobe Premiere Pro will simply take a little 
longer to upconvert your audio during the conforming process. 
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3	 Open the Source Monitor Fly-out Menu and select Audio Units.

That switches the Time Ruler from the standard video-oriented time increments 
(seconds; frames) to audio samples.

4	 Drag the left handle of the Viewing Area Bar to the right to zoom in on the Source 
Monitor timeline until the difference between numbered markers is 1,000 samples (use 
the following figure for a reference).

5	 Type in 1:0 in the Current Time Display and press return.

6	 Press the Left Arrow key once and note that the sample that precedes 1:0 is 0:47999.

There are 48,000 audio samples per second in this clip (48kHz). Switching to Audio 
Units enables you to make sample-specific edits down to (in the case of this project’s 
settings) 1/48,000 of a second. This might seem like splitting hairs, but there are times 
when cutting audio with this precision will come in handy.

Note: Audio units display with colons (:) versus semi-colons (;) for Video frame timecode.

7	 Drag the center of the Viewing Area Bar to the left and right to take a closer look at 
the audio peaks and valley.
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Note: You can drag the right or left handle of the Viewing Area Bar to change the zoom 
level.

8	 Double-click the monaural music clip in the Project panel and play it in the Source 
Monitor.

The clip I used for this task is the Adobe Audition 2.0 theme song. Notice the tall 
thin line at 1:45:09620 (refer to the next figure). That is a drum hit. You can use the 
waveform display to find sounds like this, including clicks and pops that you might want 
to remove or edit around.

9	 Double-click stereo music clip in the Project panel and take a look at it in the Source 
Monitor.

This is how a stereo signal looks. The display follows the industry standard: left channel 
on top, right on the bottom.

Note: In the clip I used for this task, the basic wave form follows what you saw in the 
monaural waveform with the exception of a segment of the right channel (highlighted in 
the following figure), where some of the instruments assigned to the right channel had a 
rest.
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10	 Select Edit > Preferences > Audio and make sure the 5.1 Mix Down Type is set to 
Front + Rear + LFE.
You need to use that setting to hear all six channels of the 5.1surround sound clip in the 
next step.

11	 Double-click the 5.1 surround sound clip in the Project panel and take a look at it 
in the Source Monitor.
It has six channels: right, left, center, right-surround (rear), left-surround (rear), and 
LFE (low-frequency effects—the subwoofer channel).

12	 Click on the 5.1 surround sound clip in the Project panel to select it and select Clip 
> Audio Options > Breakout to Mono.
That creates six links, one for each channel (it does not create six new audio files). Using 
Breakout to Mono lets you edit individual channels of a stereo or 5.1 clip. For example, 
you might want to give the LFE channel a bass boost. That does not change the original 
5.1 clip. You can link this edited channel to the other separate 5.1 channels and create 
another 5.1 clip.
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   Waveforms Are Immutable

Nothing that you do in Adobe Premiere Pro will affect the original audio or video clip or 
the visible audio waveform. If you change a clip’s volume or apply audio effects to it, the 
waveform will always display the clip’s original volume levels. 

13	 Drag the 5.1 clip to the Timeline and notice that Adobe Premiere Pro will not let 
you drop it in the Audio 1 track.
Audio 1 is a stereo track. When you drag an audio clip to a sequence that does not have 
a track that matches the clip’s type, Adobe Premiere Pro automatically creates a new 
track to suit that clip type. Even though Adobe Premiere Pro appears to move the new 
clip below the Master Audio Track, the new track will appear above the Master Audio 
track once you release the mouse button.

Note: When I set up the sequence for this task, I started with only one stereo audio track. 
Your default sequence will likely have three stereo audio tracks.

14	 Expand the view of the newly-added Audio track by clicking its Collapse/Expand 
Timeline disclosure triangle to open its waveform view, dragging the boundary between 
Video 1 and Audio 1 up the screen, and dragging the bottom of the 5.1 audio track 
down.
Your sequence should look like the next figure. Note the labels for each of the six 
channels in this 5.1 surround sound clip.
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15	 Click the drop-down list of clips added to the Source Monitor (highlighted in the 
next figure) and select monaural music clip.

16	 Move the Timeline CTI to the beginning of the sequence.

17	 Click the Overlay button and note that because there probably is no mono audio 
track in your sequence, Adobe Premiere Pro adds a mono audio track below the 5.1 
track and inserts that clip there.

Note: You can tell the audio track type by its icon: Mono is a single speaker, Stereo is 
a double-speaker, and 5.1 says 5.1. The Master audio track is stereo by default for this 
particular sequence. You can change that in the Project Settings > Default Sequence.
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Task: Adjusting Audio Volume
You might want to decrease or increase the volume of an entire clip or parts of a clip. 
For example, you might want to bring the natural sound on a video clip down by half 
while you narrate, gradually fade up the audio at the start or end of a clip, or fade up an 
interview just as the narrator completes a segment. The latter is part of a J- or L-cut. I 
explain them in the next task.

1	 Select Window > Workspace > Editing (or any other workspace) to get your 
workspace back in order.

2	 Delete the audio clips in the Timeline by marquee selecting them and pressing delete.

3	 Delete all the audio tracks except a single stereo track by right-clicking an audio track 
header, clicking Delete Audio Track in the Delete Tracks window, and clicking OK.

Your sequence should end up having only two audio tracks: Audio 1 and Master (both 
are stereo).

4	 Drag the stereo music clip from the Project panel to the Audio 1 track.

5	 Expand the track view by clicking the Collapse/Expand Track disclosure button.

6	 Click the Show Keyframes button (highlighted in the next figure) and select Show 
Clip Keyframes.

This lets you edit a clip’s volume in the Timeline rather than the volume level of the 
entire track.
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7	 Hover your cursor over the Volume Level Graph—the thin, horizontal yellow line 
between the left and right channels—until it turns into the Vertical Adjustment Tool 
cursor (highlighted in the next figure) and then drag that yellow line up and down.

Note: A dB (decibel) level readout gives you feedback on the volume change. It’s not all that 
easy to move to an exact setting. You use the Effect Controls panel Volume effect to do that.

8	 Ctrl+click the Volume Level Graph in four places evenly spaced along the yellow line.

That places four keyframes on the volume line.

9	 Drag the first and last keyframes all the way to the left and right respectively to place 
those keyframes on the first and last frames of the clip.

10	 Drag the second and third keyframes left and right respectively to about two 
seconds from the beginning and end.

11	 Drag the start and end keyframes all the way to the bottom of the clip view to create 
a fade up and a fade out.

12	 Play the beginning and end of the clip to see how this works.
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Note: As you slide keyframes around in the clip you will invariably change their volume 
setting values. Adjusting keyframes on the Timeline is a quick way to add keyframes that 
you can fine-tune in the Effect Controls panel later.

13	 Right-click on the second and third keyframes and select Ease In and Ease Out 
respectively.

Note: As you can see, you can apply Keyframe Interpolation in the Timeline. However, 
selecting one of the Bezier curve options would create a more pronounced curve in the 
middle. So stick with Ease In and Ease Out for most audio keyframes.

Adjusting Audio in the Effect Controls Panel

The Audio fixed effect works like any other effect in that you can use keyframes to 
change audio over time. Also you can apply an audio transition (which changes audio 
volume levels over time) and adjust its settings in the Effect Controls panel.

1	 Make sure the stereo music clip is selected on the Audio 1 track and open the Effect 
Controls panel.

2	 Twirl down the Volume disclosure triangles and widen the Effect Controls panel so 
you can see its timeline.

If the timeline is not open, click the Show/Hide Timeline View chevron button. Make 
note of a few things:

•	 Bypass—This is something you haven’t seen up to this point because video effects 
don’t have this option. All the audio effects have this feature. In this case it lets you 
switch back to the default volume setting at any point in the clip by turning on Bypass. 
It’s keyframeable so you can switch the effect off and on any number of times within the 
clip.

•	 Level—The only adjustable parameter.

•	 Keyframes—All the keyframes and Keyframe Interpolation methods (hourglass 
icons) you applied show up in the Effect Controls timeline (click the Show/Hide 
Timeline View to see them).
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3	 Adjust some keyframes and their parameters. Click Bypass and experiment with that.

4	 Marquee select all the keyframes in the Effect Controls timeline and press Delete.

5	 Drag the Constant Power audio transition (Audio Transitions > Crossfade) to the 
beginning of the clip on the Timeline.

6	 Click the transition rectangle on the clip to select it and view its parameters in the 
Effect Controls panel.

7	 Change the duration to three seconds.

That gives you a nice fade-in.

8	 Do the same for the end of the clip and you have a fade-out.

Replace the clip on the sequence with two music clips.

9	 Trim the end and beginning of the clips respectively to give them tail and head 
frames for a smooth transition.

10	 Drag Constant Power to that edit point and listen to how that works. 

11	 Replace Constant Power with Constant Gain and listen to it.
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Task: Adding J-Cuts and L-Cuts
Frequently you'll want to start a video clip by having its sound play under the previous 
video clip and then transition to its associated video. This is a great way to let your 
audience know that someone is about to say something or that a transition is coming. 
This is called a J-cut, so named because it looks vaguely like a ‘J’ on the sequence.

Conversely, another slick editing technique is to let the audio tail off under the next 
video clip. This is an L-cut.

To do either of these cuts requires that you unlink the audio and video portions of a 
linked A/V clip so you can edit them separately. After they've been unlinked, you can 
move that audio segment to another audio track and then extend or shorten the audio 
portion to make the J- or L-cut. There are two unlinking methods—a right-click context 
menu and a keyboard modifier. I’ll show you both.

1	 Delete all the clips in the Timeline and add, in this order, a cutaway (with natural 
sound), a sound bite, and another cutaway (or re-use the first one).

Your Timeline should look like the next figure. Your goal is to have the first cutaway 
video play over the first few words of the sound bite audio and then the have the video 
dissolve to the interview clip while the cutaway audio fades out—a J-cut. You’ll reverse 
that process for the end of the sound bite—an L-cut.

   Favor Constant Power

Constant Gain changes audio at a constant rate in and out as it transitions between 
clips. This can sometimes sound abrupt. Constant Power creates a smooth, gradual 
transition, like a video cross dissolve. It decreases audio for the first clip slowly at first 
and then quickly falls off at the end of the transition. For the second clip, this audio 
crossfade increases audio quickly at first and then more slowly as it reaches the end 
of the transition. Constant Power is the default audio transition. Rely on it for most 
transitions. But your ears are the best judge. In this particular case, you might prefer 
Constant Gain.

   Favor Constant Power

Constant Gain changes audio at a constant rate in and out as it transitions between 
clips. This can sometimes sound abrupt. Constant Power creates a smooth, gradual 
transition, like a video cross dissolve. It decreases audio for the first clip slowly at first 
and then quickly falls off at the end of the transition. For the second clip, this audio 
crossfade increases audio quickly at first and then more slowly as it reaches the end 
of the transition. Constant Power is the default audio transition. Rely on it for most 
transitions. But your ears are the best judge. In this particular case, you might prefer 
Constant Gain.
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2	 Right-click the sound bite clip and select Unlink.

3	 Complete the Unlink process by clicking outside that clip in the Timeline to 
deselect it.

Now when you click on either the audio or video portion of that clip, only that 
portion is selected. You’ll re-link these clips, then use a keyboard modifier to 
temporarily unlink them.

5	 Shift+click on both of those unlinked clips to select them (if one is already 
highlighted, there’s no need to Shift+click on it).

6	 Right-click on one of them and select Link.

Now you’ll use the keyboard modifier unlinking method.

7	 Alt+click on the audio portion of the second clip. That unlinks it and selects it.

8	 Drag that unlinked audio portion of the second clip straight down to the 
Audio 2 track.

If there is no available audio track, simply drag it below the audio tracks and 
Adobe Premiere Pro will add a track.

Note: Take care as you move the audio portions of your clips in the sequence that 
you don’t slide them left or right when you drag them. Otherwise the audio and 
video will get out of synch. Adobe Premiere Pro gives you a visual cue to help you 
line up your clips: if you see a black line with a triangle, your clips are properly lined 
up. If that black line disappears, you have moved out of synch.

9	 Using the Rolling Edit Tool (N) to move the edit between the first and second 
video clips (not the audio clips) to the right about one second to move the horse 
and rider off camera before showing the interview clip.

Use the Program Monitor and the Timeline pop-up timecode displays to help 
make the edit. In the example used for this task, I had the interviewee (the rider) 
move off screen before making the cut to the interview sound bite to create a 
more comfortable shift.
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10	 Drag the left edge of the audio portion of the second clip to the left to give you 
some room to fade it up.

11	 Apply four keyframes (use the following figure as a guide):
•	 First audio clip—You will fade the audio at the end of the clip down just before 
the sound bite (the second clip) begins. To do that, place a keyframe at that point (use 
the beginning of the waveform in the second clip to find that spot) and place another 
keyframe at the end of the first clip. Drag the end keyframe all the way down to fade the 
cutaway audio out.

•	 Second audio clip—At the beginning of the clip and just as the sound bite starts. 
Drag the beginning keyframe all the way down to have that sound bite audio fade up.

12	 Play that J-cut. The cutaway’s natural sound should fade as the sound bite begins.

13	 Drag a Cross Dissolve video transition to the edit point between the two video clips 
to make this work even more smoothly.

Adding an L-cut

Now that you’ve unlinked the center clip, adding an L-cut at the end of the piece will 
take only a few steps.

1	 Move the Timeline CTI to a second or so before the sound bite audio ends.
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2	 Drag the entire third clip (not the left side but the whole clip) to the left until the Snap 
feature causes its first frame to line up with the CTI.

This cutaway will cover up the video portion of the sound bite’s last few words but the 
audio portion will play along with the audio of the third clip—the cutaway.

3	 Add six keyframes as follows (use the next figure as a guide):

•	 Second audio clip—Put one keyframe directly after the audio in the sound bite ends 
and another one at the end of the clip. Drag the end keyframe all the way down to fade 
that sound bite audio under the cutaway.

•	 Third audio clip—At the start, a half-second or so into the clip, a half-second or so 
before the end of the sound bite and directly after the sound bite audio ends. Drag the 
first keyframe all the way down, move the second and third to about –9 dB (to play the 
cutaway audio quietly under the sound bite), and the fourth to full volume or 0 dB (move 
the volume graph to the center of the clip (its default position), between the right and left 
channels).

4	 Add a video Cross Dissolve between the video portions of these two clips.

5	 Play that L-cut.

The closing B-roll’s natural sound should fade up quietly beneath the sound bite’s closing 
comment, then climb to full volume at the end.



Review
Review questions
1	 Why should you use external mics?

2	 When you set up a voice recording space in the corner of a room, which way do you 
face to voice the narration and why?

3	 If you videotape indoors and your audio has a "tin-can" quality what do you think is 
going on?

4	 You want to start your piece by fading up your audio. Explain three ways to do that.

5	 Why use an L-cut or a J-cut?

6	 You have a quiet video clip, but in the middle someone honks a car horn. How could 
you remove that sound and replace it with the original quiet background of the original 
clip?

Review answers
1	 Your camcorder's onboard mic picks up sound all around you, including noise you 
make when handling the camcorder. External mics capture sound at the source. Using 
external mics is invariably better and greatly improves the quality of your production.

2	 As counter intuitive as it seems, you face away from the sound absorbing material. 
The mic picks up sound from the direction it's facing. The absorbing material minimizes 
the reflections the mic picks up.

3	 The mic is probably too far from your subject and you're in a room with reflective 
surfaces such as flat walls and an uncarpeted floor.

4	 Drag an Audio Crossfade transition (Constant Power or Constant Gain) to the 
beginning of the clip. Or use the Volume Graph in the Timeline clip display with two 
keyframes, dragging the first keyframe to the first frame and dragging it to the bottom 
of the clip. Or use the Volume audio effect and two keyframes to fade up the audio. Use 
interpolation controls to smooth what would otherwise be a straight-line fade-in.

5	 To either ease into a clip, such as a sound bite, or to let it fade out. A J-cut starts audio 
under the preceding video (which also has associated audio) and then fades up as you 



transition or cut to the video portion of that clip. An L-cut fades audio under the 
next clip as a way to ease out of that audio/video clip.

6	 Use keyframes to silence that portion of the audio. Then add part of the 
original audio to another audio track and fade that up to fill the audio gap you 
created in the original clip. Adobe Audition has several tools to remove noises 
effectively. I cover it in Module 12.

Exercises and Activities
1	 Build a simple two-wall voice-recording area using the methods described in 
this module. Experiment with mic placement, distance from your mouth, and 
whether the mic points toward or away from the sound absorbing material. Listen 
critically to the audio quality. Tinny, noisy, muffled, too much echo, or just right. 
Find what works best for you.

2	 Work on your narration style. Do several voice-overs using the same script. 
Listen to your inflection, cadence, and pauses. Do you sound interested in the 
subject matter? Do you enunciate clearly without sounding pedantic? Try to find 
a comfort level between overly enthusiastic and bored. And feel free to combine 
narration segments from different takes. No one take has to be perfect.

3	 Check the Yellow Pages for Recording Service or Recording Studio and pay 
one or two a visit. I took some high school students to a studio in Portland, 
Oregon, and we had a blast. The sound engineer demonstrated some amazing 
voice-sweetening tricks.

4	 J- and L-cuts should be a part of every production. The only way that's going 
to happen is if you get comfortable doing them. Make a few of each.

5	 When using a narration, typically you'll lay down some of that voice-over, put 
in a clip with some nice natural sound, and then add more narration and more 
natural sound throughout your story. Give that process a try by cutting your 
narration with the Razor tool and inserting natural sound clips at those breaks 
(hold down the Ctrl key when dragging clips to the razored point to perform an 
insert edit, thereby sliding clips to the right). Use J- and L-cuts liberally. 


